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Thank you for purchasing our product. If there are any questions, or requests, please do not hesitate to
contact the dealer.

Notice
CAUTION!
The default password is used for your first login. To ensure account security, please change the
password after your first login. You are recommended to set a strong password of no less than
eight characters comprising at least three elements of the following four: digits, upper case
letters, lower case letters and special characters. For security reasons, access from Internet with
weak password will be denied until it is changed to a strong one.


The contents of this document are subject to change without prior notice. Updates will be
added to the new version of this manual. We will readily improve or update the products or
procedures described in the manual.



Best effort has been made to verify the integrity and correctness of the contents in this
document, but no statement, information, or recommendation in this manual shall constitute
formal guarantee of any kind, expressed or implied. We shall not be held responsible for any
technical or typographical errors in this manual.



The illustrations in this manual are for reference only and may vary depending on the version or
model. So please see the actual display on your device.



This manual is a guide for multiple product models and so it is not intended for any specific
product.



Due to uncertainties such as physical environment, discrepancy may exist between the actual
values and reference values provided in this manual. The ultimate right to interpretation resides
in our company.



Use of this document and the subsequent results shall be entirely on the user's own
responsibility.

Symbols
The symbols in the following table may be found in this manual. Carefully follow the instructions
indicated by the symbols to avoid hazardous situations and use the product properly.
Symbol

Description

WARNING!

Indicates a hazardous situation which, if not avoided, could result in bodily injury
or death.

CAUTION!

Indicates a situation which, if not avoided, could result in damage, data loss or
malfunction to product.

NOTE!

Means useful or supplemental information about the use of product.
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Introduction
The Video Management Server (referred to as VMS hereinafter) is a new generation video
management device designed to meet security surveillance needs from small and medium-sized
businesses.
The VMS offers three access methods.
Method

Description

Web Manager

Use a Web browser to access the VMS to manage, configure devices and services
and perform maintenance operations. Simple video service is available on the Web
Manager.

Client
Software

Access the VMS through the client software installed on your computer to perform
service operations.

Mobile App

Access the VMS through a mobile app for live view, playback and device
management.

This manual describes how to use the client software.

2

Install and Upgrade Client Software
The client software runs on Windows PC. Win 7 or Win 8 is recommended.

NOTE!
The PC must run a 32-bit operating system, or a 64-bit operating system compatible with 32-bit
software. The client software is not compatible with pure 64-bit operating systems.

Download
Download the setup file from the login page of the Web Manager:
1.

Open a Web browser and then enter the VMS' IP address in the address bar, e.g., 192.168.1.60.
The login page is displayed.

2.

Click the EZVMS Client icon to download the setup file.

Install
Double-click the setup file to start installation. Click Next and follow the wizard to complete the
installation.
1

Upgrade
To install the new version in the same directory as the current version, run the setup file of the new
version directly. The current version will be uninstalled, and then the new version will be installed
automatically.

NOTE!
An upgrade or a reinstall does not restore the admin's password to 123456 (default password).

Uninstall
Use the following methods to uninstall:


Use the uninstall function provided in the control panel of the Windows operating system.



Double-click the setup file. A dialog box appears. Click Next, and then choose the delete option.

View Version Info
Log in, click

in the upper left corner (see GUI Introduction), and then select About

EZVMS from the drop-down menu.

Double-click the version to view detailed version info, including internal version and build date.

2

NOTE!
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The client software downloaded from the login page of the Web manager matches the VMS device
version.
When accessing the VMS using a lower version of client software, you will be prompted to upgrade
the client software. You may click to download.
When accessing the VMS using a higher version of client software, you will be prompted to
upgrade the VMS device. You may ignore the prompt and continue to log in, but compatibility issue
may occur.

Login
The client software provides two login methods:


Login by IP: You need to enter the IP address, port number, username and password to log in.



Login by cloud: Log in with a cloud account. You need to sign up for a cloud account at the cloud
website and add the VMS to cloud first. No VMS username and password is needed if you log in
using this method.

Login by IP
Enter the IP address, port number, username and password of the VMS and then click Login.

NOTE!







The default username/password is admin/123456.
The default port number is 80. Use the actual port number to log in if it has been changed.
If you log in with Save Password selected, the entered username and password will be
remembered and filled in automatically at your next login.
If you log in with Auto Login selected, you will skip the login step at your next login.
The IP addresses of the VMS that you have successfully logged in are remembered and listed.

Login by Cloud
NOTE!
You need to sign up for a cloud account at https://en.ezcloud.uniview.com and add the VMS
before you can log in by cloud. For the detailed steps to sign up for a cloud account, click Help in
the upper right corner of the web page.
After you have signed up for a cloud account and added the VMS to cloud, follow the steps to log in
by cloud:
1.

Click Cloud.

2.

Select International.
3

4

3.

Enter your cloud account username and password.

4.

Click Login.

5.

When logged in successfully, a dialog box appears, showing your cloud account name and lists
the VMS you have added.

6.

(Optional) Click the Network Detect button to detect the NAT type of the client (e.g., Port
restricted cone NAT).

7.

Select one VMS and then click OK.

GUI Introduction
The main page is displayed after your first login. The main page consists of Control Panel, shortcut
menu and some functional buttons.

No.
A

Description
Click to display the pull-down menu.
Note: The menu items may vary with the roles the user is assigned.

B

The control panel lists icons of functional modules of the software client. Click an icon
to open the corresponding page.

C

Current username, for example, admin. To switch account and log in as a different
username, click the icon.
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No.

Description

D

Click to lock. To unlock, enter the password.

E

Help button. Click to open the user manual for the client software. A PDF reader tool is
required.

F

Common function area. You may drag an icon to switch position with another icon, or
drag it to the basic function area.

G

Basic function area. You may drag an icon to switch position with another icon, or drag
it to the common function area.
Click to open the latest alarm list and view the latest alarms, including alarm time,
alarm source, alarm type, and alarm sound.

H

To enable or disable alarm-triggered live video, select or clear the Display Link Video
check box.
To turn on or off alarm sound, click the alarm sound icon.
Task Management button. Click to view recording download tasks, including file name,
recording start time and end time, and download progress.
The operation column includes icons that you may click to stop download, open folder
or delete tasks.

I

To stop a download task, select the task and then click
To clear completed tasks, click

.

.

J

Search for recordings and download.

K

IP address of the current VMS.

NOTE!
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The functional modules on Control Panel may vary with VMS and software client version.
The functional modules, organizations and resources displayed and operations allowed on the
software client depends on the role(s) a user is assigned. Roles are configured under Basic > User >
Role on the Web Manager.

Live View
Click the Live View icon on Control Panel. The Live View page is displayed. View live video from
cameras and use the toolbar to control live view.

Glossary


Live view: View live video.



Video channel: One video channel corresponds to one camera.
5



View: A combination of screen layout (such as 4-window) and service (live view or sequence). By
saving a view, you can quickly resume service in the set layout by clicking the Play button. For
more details, see View Configuration.



Layout: How many windows to display on the Live View page. Up to 64 windows are allowed.



Fisheye camera: Cameras with super-wide-angle lens.



History: Last cameras that have been played for live video. Up to 30 cameras are listed.



Favorites: Add certain cameras (such as the frequently used) to Favorites folders for better
management.



Sequence resource: Specified cameras to play live video on the client in sequence at the set
time interval.

Play Live Video
Play live video from online cameras.


Online:



Offline:

The organization tree shows the number of online cameras and the total number of cameras (e.g.,
7/10 in the figure below).

Play Live Video from a Camera
Double-click the camera or drag it to a window.

To stop live video, click

in the window's upper right corner. Clicking

video in all windows.
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in the toolbar stops live

Play Live Video from Multiple Cameras
For example, to play live video from all the cameras under an NVR, double-click the NVR or drag it to
a window.

Play a View
A view is a combination of screen layout (e.g., 4-window display) and service type (live view or
sequence). Complete view configuration first (see View Configuration), and then start live video or
sequence in the corresponding windows by clicking the Play button.
1

2

1.

Click the View tab (

2.

Click the Play button (

3.

Click

,

,

).
) for the view to play.

to add, edit or delete a view.

Play Sequence Resource
Play live video from several cameras in a window in sequence. The cameras switch automatically in
the set order at the set time interval. You need to configure sequence resource first (see Sequence
Resource).
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1

2

1.

Click the Sequence Resource tab (

2.

Double-click the sequence resource or drag it to a window.

3.

Click

,

,

).

to add, edit or delete a sequence resource.

Live View Operations
Use the live view toolbar, window toolbar, shortcut menu during live view.

Live View Toolbar
The live view toolbar is located at the bottom of the Live View page.
A

B

C

E

D

No.

F

G

Description
Click to set screen layout. Up to 64 windows allowed.

A

B

Click to save the current view or save as another view.

C

Close video in all windows.
Take a snapshot of video playing in all windows.

D

Snapshot mode, snapshot format and save path are configurable (see Client
Configuration).

E

Pause/resume sequence.
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H

No.

Description

F

Play the previous camera in a sequence resource.

G

Play the next camera in a sequence resource.

H

Play in full screen or exit. You may also press Esc to exit full screen.

Window Toolbar
A window toolbar appears when the pointer rests on the window. The toolbar is effective to the
current window only. Buttons on the toolbar may vary with camera. For example, button 2 (PTZ
control button) in the toolbar below appears only for a PTZ camera.
0

1

2

3

4

5

6

7

8

9

No.

Description

0

Take a snapshot and save it to your client computer.
The snapshot mode, format and save path are configurable (see Client Configuration).
A snapshot taken with digital zoom enabled is a composite image of the original image
(display on left) and the zoomed-in image (display on right).

1

Local recording (record video to your client computer). Click
is configurable (see Client Configuration).

to stop. The save path

Available to PTZ cameras only. Click to open the PTZ control panel (see PTZ Control).
2

3

The fisheye icon
appears on the toolbar for a fisheye camera only. Clicking the icon
will open the fisheye control panel (see Fisheye Control).
Digital zoom. Click to enable, drag the mouse to draw an area on the image to zoom in
on, and then use the scroll wheel to zoom in or out. Click

to disable.

4

Adjust the output sound volume on your client computer or mute.

5

Two-way audio.
Instant playback (play video of the last 5 minutes and 30 seconds).


Click

to pause or

to resume.

To stop playback and resume live video, click
.
 To stop playback without resuming live video, click the close button in the upper
right corner.
Note:
 Before using instant playback, you need to set a recording schedule and make sure
the client computer's system time is synchronized with time on the VMS.
 Live video does not resume automatically when instant playback stops at the end.
You need to resume live video manually.
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9

No.

Description
Alarm output control: click
clear.

7

to trigger the linked alarm output, and click

to

The linked alarm output is configured at Basic > Device > Link Resource on the Web
Manager.
Click to set video settings, including image brightness, saturation, contrast and
sharpness.

8

Click Reset to restore default settings.
9

Current bit rate and resolution (example).

Shortcut Menu
A shortcut menu appears when you right-click a window in which live video is playing (menu items
may vary depending on camera, version, user permissions). Some menus have same functions as the
window toolbar (see Window Toolbar).
Menu Item

Description

Close

Close video in the current window.

Close All

Close video in all windows.

Display Ratio

Play by scale or stretch.

Maximize

Maximize the current window to the entire display area.

Full Screen

Display in full screen.

Digital Zoom

Enable/disable digital zoom. See

on Window Toolbar.

Instant Playback

Start/stop instant playback. See

on Window Toolbar.

Two-way Audio

Start/stop two-way audio. See

Stream Type

Choose a stream type to play (main, sub, third, may vary with camera).

Snapshot

Click to take a snapshot. See

on Window Toolbar.

on Window Toolbar.

Click to take multiple snapshots.
Continuous Snapshot

The snapshot mode, snapshot format and save path are configurable
(see Client Configuration).

Snapshot All

See

Local Recording

Start/stop local recording (to client computer). See
Toolbar.

Central Recording

Start/stop central recording (to a slave server). Closing the window or
logout will also stop central recording. To play back such recordings,

on Live View Toolbar.
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on Window

Menu Item

Description
click the Center tab on the Playback page (see Basic Operation in
Playback).

Alarm Output Control

See

on Window Toolbar.

PTZ Control

See

on Window Toolbar. Available to a PTZ camera only.

Video Settings

See

on Window Toolbar.

Camera Info

View info such as frame rate, resolution, bit rate, video compression
(e.g., H.265) or packet loss rate of the current camera.

Client Configuration

Open the client configuration window. See Client Configuration.

Other Operations
The following introduces some useful operations during live view.


Right-click a camera to select a stream type (main, sub, third; may vary with camera).



Search with keyword. Enter a keyword in the



Drag image to switch windows, for example, drag image from window 1 to window 4. If window
4 is also playing, then window 1 will play the image in window 4.



Double-click a window to maximize. Double-click again to restore.
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field, e.g., 109.



View the name of the camera that is playing in a window: hover the pointer on the window and
the camera name appears.



Click a window, and the corresponding camera is highlighted on the camera list.

Favorites
Add cameras to Favorites folders as needed. A camera belongs to one Favorites folder only.
Add Favorites
1

2

3
4

5

1.

Click the Video Channel tab (

2.

Click the Add Favorites button (

).
). To add to My Favorites, click to select the My Favorites

folder and then click OK.
3.

To create a Favorites folder, click the New Folder button.
12

4.

Enter a folder name.

5.

Click OK.

When added successfully,

appears when the pointer hovers over the camera.

You will also find the new Favorites folder with the camera on the Favorites tab.

Delete Favorite
To delete a camera from a Favorites folder:


On the Video Channel tab, click Delete Favorite button (



On the Favorites tab, click to select the camera, and then click the Delete button (

2

1

View Live Video
To view live video from a camera in a Favorites folder:


Double-click the camera or drag it to a window.
13

).
).



Double-click the Favorites folder to play all the cameras in the folder.

Manage Favorites Folder
Manage Favorites folders and cameras on the Favorites tab: create, delete, rename Favorites folders,
add or delete cameras.


To create a Favorites folder: Click the New Folder button (



To delete a Favorites folder: Click to select the Favorites folder and then click the Delete button
(



).

). Deleting a Favorites folder also deletes all the cameras in it.

To rename a Favorites folder: Click to select the Favorites folder and then click the Rename
button (

). The root folder (My Favorites) cannot be renamed.

History
Click the History tab (

) to view the last cameras (up to 30) played for live view (not

including view and sequence).
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Double-clicking a camera or dragging it to a window will start live video from it. Clicking the Clear
History button (

) will clear the history.

PTZ Control
Control the surveillance direction, focus and zoom of PTZ cameras.
PTZ control is only available to a PTZ dome camera or a camera mounted on a pan/tilt motor that
supports PTZ control. The actual functionality depends on the functions of the camera and the PTZ
control protocol.
Click

on the window toolbar to open the PTZ control panel. The panel expands and collapses

with a click on the arrow at the bottom.
Some PTZ control functions are described in the table below.
Tool

Description
Control rotation directions or stop rotation.
Note:
You may also use the mouse to change the surveillance direction in the
live view window: move the pointer toward the side of the window
you want to view; when the pointer changes shape ( ), click the
mouse button to move, or press and hold the mouse button to keep
moving. The camera will rotate in that direction. Release the button to
stop.
Adjust focus and zoom.
Note:
Alternatively, click anywhere on the image and then use the scroll
wheel to zoom in or out.
Adjust rotation speed.
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Tool

Description
When 3D positioning is enabled, the PTZ rotates to the direction you
click on the screen. Drag the mouse to zoom in or out on the image.
Set presets:


: Click to add a preset.



: Click to go to a preset.



: Click to delete a preset.

Note:
Use an unused preset number when adding a new preset; otherwise,
the existing preset will be replaced.
Set patrol, including preset patrol and recorded patrol.


Preset patrol: The camera automatically moves in the order of
presets repeatedly at the set time interval. Click
to add: in the
Add Patrol dialog box, click Add, select a preset from the
drop-down list (or click New Preset to add) and set a stay time.
Repeat the above steps to add all presets to include, and then
adjust the order of presets as needed. After creating a preset



patrol, you may click
to edit a preset patrol.
Recorded patrol: The camera moves along the recorded route.
Click

to start recording. Rotate the camera to the intended

directions and stay for the desired length of time. Click
to
stop recording. To start recorded patrol, select from the
drop-down list and then click

to start.

Note:




A preset patrol includes up to 32 presets; a PTZ camera allows up
to 15 preset patrol routes.
Currently only one recorded patrol route is allowed.

Set auto guard. When enabled and configured, the camera
automatically executes the preset action, e.g., go to a preset or start
patrol, if no patrol or other action is performed within the set time.

Fisheye Control
A fisheye control icon (

) appears in the window toolbar when the camera is a fisheye. Click the

icon or use the shortcut menu to open the fisheye control panel.
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Choose the correct mounting mode for the fisheye camera: ceiling, wall or desktop, and then display
modes appear, e.g., 360° Panoramic, 180° Panoramic, Fisheye, PTZ (appears when the pointer rests
on it). Display modes and operations supported vary with mounting mode.
On a PTZ image, you may drag the mouse to rotate the image or use the scroll wheel to zoom in or
out. A block appears on fisheye or panoramic image as the image rotates, and as you drag the box or
move the scroll wheel on the fisheye image, the corresponding PTZ image rotates or zooms in or out
as well.

6

Playback
Click the Playback icon on Control Panel. The Playback page is displayed. Search and play recordings
saved on a slave VMS or on an NVR.

Glossary


Video channel: One video channel corresponds to one camera.



Center: Source of recording, means recordings saved on a slave VMS.



Device: Source of recording, means recordings saved on an NVR.



Backup: Recordings that are automatically replicated from NVR to a slave VMS according the set
schedule. Backup recording only supports normal recording playback mode.



Playback types: Includes normal recording playback, tagged recording playback, locked
recording playback, and event recording playback. Choose from the drop-down list in the upper
left corner on the Playback page.



Favorites: Add cameras to different Favorites folders as needed.



Lock: Lock important recordings to prevent them from being overwritten when storage space is
used up.



Tag: Tag recordings to mark certain events, and then use tags to find needed recordings quickly.



Play to Video Wall: Play recordings on the video wall.
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Function Description
The software client offers multiple playback modes to meet different needs. The playback mode
supported, functions available, and operations allowed may vary depending on the source of
recording. For example, backup recording only supports normal recording playback.
Mode

Description

Normal recording playback

Search results in this mode include all recording types (scheduled,
manual, event).

Tagged recording playback

Use tags to find needed recordings quickly. Available to center
recordings (recordings saved on a slave VMS) only.

Locked recording playback

Search and play locked recordings. Available to center recording
only.

Event recording playback

Search and play recordings triggered by an event (such as motion
detection).
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Normal Recording Playback
Basic Operation
1
2

3

4

5

1.

Choose the video source: Center or Device.

2.

Select playback mode: Normal Recording Playback.

3.

Select cameras (up to 16). The calendar shows recording status: blue means normal recording,
red means event recording, and white means no recording.

4.

Select a date with recordings.

5.

Click Search. Search results appear on the timeline and the Recording list on the right. Different
recording types are shown with different colors on the timeline: blue for normal (scheduled),
and red for event (alarm).
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NOTE!
For center recordings (recordings saved on a slave VMS), if search results include locked or tagged
recordings, they will also be shown on the timeline and the list on the right. See Create tags and
Lock recording.
6.

When the pointer hovers on the timeline, the corresponding time appears. Click anywhere on
the timeline, video starts playing from that point.

7.

On the Recording list on the right, double-click a file to play, or click the play button (

).

Other Operations
Search and play recordings of another date for the camera playing in the current window

Click the calendar icon and then select a date. Search results play automatically; no need to select
cameras and click Search again.
Search and play in other window(s)
1.

Click to select another window. Note: If you do not select another window, search results will
play starting from the current window.

2.

Repeat the steps in Basic Operation.
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Adjust the width of the playing area

2

1



Place the pointer on the left boarder (such as 1). When the pointer changes shape, drag the
border left or right to adjust the width of the playing area.



Click the button (2) to hide/expand the file list.

Create tags
This function is available to center recordings only. Create tags to mark certain time points on a
recording, and then use Tagged Recording Playback to search and play tagged videos. Device
recordings (video recorded on an NVR) do not support this function.


Click

to create a default tag quickly without pausing playback. All default tags are saved

automatically as TAG.


Click

to create a tag with a custom name. Playback pauses when you create a custom tag

and resumes when the tag is created.


The white lines on the timeline indicates the created tags (



On the Tags list on the right, double-click a file to play, or click the play button (
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)
).



Click

to rename the tag; click

to delete a tag.



By default, a tagged recording starts 30 seconds before the tag time. You may change the
setting in the Start Before(s) field.

NOTE!
A custom tag created during synchronous playback is created for all the recordings that are playing.
Lock recording
This function is available to center recordings (video stored on a slave VMS) only. Lock important
recordings to prevent them from being overwritten when storage space is used up, and use Locked
Recording Playback to search and play locked videos. Device recordings (videos that are saved on an
NVR) do not support this function.


Click



Set times precisely in the dialog box and enter a description (e.g., reason for locking the
recording).



A lock icon appears at the start position of the locked recording. Click the lock icon, the locked
recording is highlighted with red, and the corresponding file is also highlighted on the Locked
Recordings list on the right. The remarks (e.g., Motion detection) also appear when the pointer
hovers on the lock icon.



In the Locked Recordings list on the right, double-click a file to play, or click the play button
(

to specify the start of the recording to lock, and click

).
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to specify the end.



Click

to unlock (unlocked recording is not protected); click

to view details about a

locked recording.


Search and play locked recordings (see Locked Recording Playback).



Download recording (see Recording Download).

Double-click a window to maximize
Double-click again to restore.

Drag image to switch window
See the figure below: drag the image from window 1 to window 4. If window 4 is also playing, then
window 1 will play the image in window 4.

Add to Favorites
Add cameras to different Favorites folders as needed. See Favorites in Live View for reference. Some
operations are similar.

Playback Control
Use the playback toolbar, window toolbar and shortcut menu during playback.
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Playback toolbar
Playback control is effective only to the currently selected window when multiple windows are
playing.
A

B

C

D

E

F

G

H

No.

I

J

K

L

M

N

Description

A

Set screen layout.

B

Close all windows.
Take a snapshot of video playing in all windows.

C

The snapshot mode, format and save path are configurable (see Client Configuration).

D

Lock recording (center recording only)

E/F

Create tags (center recording only), including default tag and custom tag.
Normal playback or synchronous playback.


G



Normal playback: Search results play automatically.
Synchronous playback: Play recordings synchronously in all windows. If other windows
are playing, playback starts automatically for the current camera; otherwise, you need
to start playback by clicking the play button.

Rewind by frame and forward by frame. Click repeatedly to view the last/next frame of
images.
Note:
 The buttons are grayed out in synchronous playback mode.
 The play button is in pause status when you are playing by frame. Click the Playback
button to resume normal playback.

H/K

I/J

Pause/resume, stop playback.

L

Adjust playback speed. Multiple options. + means play forward, - means play backward.

M

Download recording (see Recording Download).

N

Switch to or exit full screen. You may also press Esc to exit full screen.

Window toolbar
After playback starts, a toolbar appears when the pointer rests anywhere on the window. The
toolbar is effective to the current window only.
1

2

No.
1

3

4

5

Description
Take a snapshot and save it to your client computer.
The snapshot mode, format and save path are configurable (see Client Configuration).
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No.

Description
A snapshot taken with digital zoom enabled is a composite image of the original image
(display on left) and the zoomed-in image (display on right).
Digital zoom. Click to enable, drag the mouse to draw an area on the image to zoom in
on, and then use the scroll wheel to zoom in or out.

2

Click

to disable digital zoom.

Clip video to download: Click

3

click

, click on the timeline to locate the end, and then

. You may set times precisely in the dialog box.

4

Adjust output sound volume on your client computer.

5

Current bit rate and resolution.

NOTE!




The fisheye icon
appears for a fisheye camera only. Clicking the icon will open the fisheye
control panel (see Fisheye Control).
During playback, you may set the video transmission protocol in accordance with network
performance to improve image quality.

Shortcut menu
After playback starts, a shortcut menu appears with a right-click on the window.
Menu Item

Description

Close

Close video in the current window.

Display Ratio

Play by scale or stretch.

Digital Zoom

Enable/disable digital zoom. See

Play To Video Wall

See Play Recording on Video Wall.

Snapshot

Click to take a snapshot. See

on Window toolbar.

on Window toolbar.

Click to take multiple snapshots.
Continuous Snapshot

The snapshot mode, snapshot format and save path are
configurable (see Client Configuration).

Snapshot All

See

Start Clipping

Start/stop local recording (to your client computer). See
Window toolbar.

Download

Download recordings (see Recording Download).

on Playback toolbar.
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on

Tagged Recording Playback
Search and play tagged recordings.

NOTE!



Only center recording (recordings saved on a slave VMS) supports this function.
To create tags, see Create tags.

1
2

3

4
5

1.

Choose the video source: Center.

2.

Select playback mode: Tagged Recording Playback.

3.

Select cameras (up to 16).

4.

Set the search time (up to 1 week).

5.

Click Search.

6.

On the Tags list on the right, double-click a file to play, or click the play button (
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).

NOTE!



The length of a tagged recording depends on Start Before(s) and Stop After(s), which set the
length of time before and after the tag time. The default settings are 30 seconds for both, which
means by default a tagged recording is 1 minute long.
Playback stops at the end of a tagged recording. You need to play the next manually.



You may click



7.

to edit a tag name, or click

to delete a tag.

Use the playback toolbar, window toolbar or shortcut menu as needed. See Other Operations
and Playback Control.

Locked Recording Playback
Search and play recordings saved on a slave VMS.

NOTE!



Only center recording (recordings saved on a slave VMS) supports this function.
To lock recordings, see Lock recording.
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1
2

3

4
5

1.

Choose the video source: Center.

2.

Select playback mode: Locked Recording Playback.

3.

Select cameras (up to 16).

4.

Set the search time (up to 1 week).

5.

Click Search.

6.

On the Locked Recordings list on the right, double-click a file to play, or click the play button
(

).
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7.

Click

to unlock; click

to view details of a locked recording.

8.

Use the playback toolbar, window toolbar or shortcut menu as needed. See Other Operations
and Playback Control.

Event Recording Playback
Search and play event recordings such as recordings triggered by motion detection.
1
2

3

4
5

1.

Choose the video source: Center or Device.

2.

Select playback mode: Event Recording Playback.

3.

Select cameras (up to 16).

4.

Set the search time (up to 1 week).

5.

Click Search.

6.

On the Recordings list on the right, double-click a file to play, or click the play button (
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).

7.

Use the playback toolbar, window toolbar or shortcut menu as needed. See Other Operations
and Playback Control.

Recording Download
Use the following methods to download recordings to your computer. The path is set at Client
Configuration (Audio & Video > Recording).


After a search, click the download button (

) on the playback toolbar. The Download

Recording dialog box appears.

Select the file(s) to download or click

to select all. Click Download.
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Click By Time to set start and end times precisely (must be earlier than the current time). Click Add
to add more download tasks.

Click the Task Management button

(see GUI Introduction) to view download progress, stop

download, play a downloaded recording, open the recording folder, or to delete a download task.
Deleting a download task will not delete the recording that has been downloaded; and closing the
Task Management dialog box will not affect download tasks.

NOTE!
You may click By Tag or By Lock to download tagged or locked recordings if there are any.



Click the Recording Download button

(see GUI Introduction) to search for and download

recordings.


During playback, use Start Clipping (

) and Stop Clipping (

clip the video you want to download. Click
the end point, and then click

) on the window toolbar to

to set the start point; click on the timeline to set

. Set start and end times precisely in the dialog box.
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During playback, click Start Clipping and Stop Clipping on the shortcut menu that appears when



you right-click the window (similar to clicking

and

).

During playback, click Download on the shortcut menu that appears when you right-click the



window (similar to clicking

).

Play Recording on Video Wall
Play recording on a video wall. You need to complete video wall configuration first
2

3

1

4

7

1.

Right-click the window during playback, and select Play To Video Wall.

2.

Select the video wall.

3.

Click to select the screen. The screen should have been bound to a decoding channel.

4.

Click OK.

5.

When video starts on the video wall,
on the Video Wall page.

appears in the top right corner of the video wall screen

E-map
Click the E-map icon on Control Panel. The E-map page is displayed. Custom maps and add
surveillance resources such as hot spots on the map to improve efficiency.
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Glossary


Hot spot: refers to video channel (camera) and alarm input that are added on the map. If a hot
spot is a camera, you may double-click the icon to view live video, or right-click the icon and
then choose from the shortcut menu to view live or recorded video.



Hot zone: A map on a map. A hot zone appears as an icon with a custom name and color. You
may double-click a hot zone icon to open the map and add hot spots on it.



Map resources: including map, hot zones and hot spots.

Map Configuration
Add a Map
For first time use, click

to add pictures. On the Edit Map tab, you may:



Click Picture Management to add or delete pictures. See Picture Management for details.



Add hot spots, including cameras and alarm inputs. See Add a Hot Spot for details.



Add hot zones: Add maps on the map. A hot zone is displayed as an icon on the map and opens
with a double-click. See Add a Hot Zone for details.

Picture Management
Click

to add pictures. Up to 40 pictures (JPG, PNG and BMP formats) are

allowed.

NOTE!
Added pictures are uploaded to the VMS server. Only pictures added as hot zones will be displayed
as map resources in the Map Resources list.
Click to edit or delete map resources.

33

Add a Hot Spot
Add hot spots so you can quickly locate them on the map when any event occurs. Hot spots include
cameras and alarm inputs.
1.

Click the Video tab (

).

2.

Drag the camera to the intended location on the map. You may right-click the icon to change its
color.

3.

Click the Alarm Input tab (

4.

Click the Map tab to view the added hot spots.

) to add alarm inputs in the same way.

Add a Hot Zone
Add a map on the map as a hot zone. The hot zone is displayed as an icon on the map and opens
with a double-click.
1.

Click

.

2.

Select a picture for the hot zone and then click the Add button.

3.

The hot zone appears on the map and the Map Resources list on the left.

4.

Drag the hot zone icon to the intended location on the map.

5.

Right-click the icon to change the color if necessary.
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6.

To edit or delete the hot zone, click to select it and then click

or

.

Map Operations
Perform the following operations on the Map tab after operations are completed on the Edit tab:


Live view: View live video from a camera by double-clicking the camera icon on the map. Up to
four cameras can be played at the same time. You may also right-click the icon and select Live
View from the shortcut menu.



Playback: Search and play recorded video of a camera. Right-click the hot spot icon and select
Playback (see Playback).



View alarm info: The hot spot flashes on the map when an alarm occurs. Right-click the icon and
select Show Alarm Info to view alarm information.



Clear alarm: Right-click the icon and select Clear Alarm.



Filter hot spots: Select

to show certain type(s) of hot spots on the map.
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Select hot spots or hot zones: Click

and drag the mouse to specify an area on the

map. A dialog box appears, listing all the hot spots and hot zones in the area. Click Live View or
Playback as needed. Live video is supported for up to four cameras at the same time.


Zoom in or out on the map: Click

or

(or use scroll wheel) to zoom in or out. Click

to restore the original size. When zoomed in, you may drag the highlighted area in the small
window (in the lower right corner) to locate on the main map.



Locate hot spot or zone on map: click

. The hot spot or zone icon is located on the map

highlighted.
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Video Wall
Click the Video Wall icon on Control Panel. The Video Wall page is displayed. After configuration is
complete on the software client, video can play on physical screens on a video wall, including live
view, playback and sequence.

Glossary


Video wall: Also known as video display wall, refers to a multi-monitor setup that consists of
multiple computer monitors or display devices (e.g., LCD panel) tiled together to form one
large screen to display a single continuous image. By binding video wall screens to decoding
channels, digital signals from encoding devices are converted into analog signals and displayed
on video wall screens.



DC video wall: Video wall created by binding decoding channel(s) of a decoding device.



Decoding channel: Output port of a decoding device.
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Video channel: One video channel corresponds to one camera.



Bind: Establish association between a video wall screen and a decoding channel.



Screen: A physical screen on the video wall, which corresponds to a window on the client
software. For easier understanding, window is also referred to as screen in this chapter. A
screen can be split into multiple screens (or windows). The number of screens configured on
the client must match that on the physical video wall.



Play on Screen: Play video or sequence resource on a specified video wall screen.



Play on Wall: Play video or sequence resource on video wall screens.



Splice: Merge multiple video wall screens to one bigger screen.



Scene: By saving certain video wall settings including screen, window and service (live view or
sequence) as a scene you can quickly restore service with one click of the button without
redoing the configuration.

Add a Video Wall
1.

For first time use, click
click

and then choose a video wall type; otherwise,

right to a video wall name.

2.

Complete the basic settings including video wall name and size. Make sure the video wall size
is consistent with the physical video wall.

3.

By default Auto-Bind Channel is selected. The software automatically binds decoding channels
to screens based on the resolution you set. You can edit the binding (drag decoding channel to
screen). The following illustration takes DC video wall as an example.
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TIP!
Decoding channels that are bound successfully are displayed as
on the decoding channel list,
and the decoding channel name appears at the screen center; Not Bound is displayed on screens
that are not bound to any decoding channels. To cancel binding for a screen, click the close button



in the screen's top right corner. To cancel all bindings, click
. Click
You can drag a screen to switch decoding channel with another screen.



to bind all.

Video Wall Operations
NOTE!
The following descriptions are not intended for a specific video wall type.
The actual operations allowed and functions available may vary depending on the decoding device.




Play Live Video on Video Wall
1.

Drag cameras to intended windows one by one; or select multiple cameras and drag at a time.

TIP!
When live video starts on the video wall, the screen color changes,
right corner, and the camera name appears at the screen center.

appears in the screen's top

K

A B

E

C

F

D

G

I
J
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A: Save current video wall settings as a scene. With one click of

in the scene list you can

resume the service without redoing the configuration.



B: Splice screens. Drag to select screens (or click while pressing Ctrl); The selected screens must
form a rectangular. Steps for cancellation are the same.
1

22

3 3



C: Start/stop decoding on all screens.



D: Windows are automatically numbered when created. After you spice screens or change their
positions, this button allows you to automatically renumber screens in top-to-down and
left-to-right order.



E: Set screen layout (for example, 4 screens).
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F: Start/stop decoding on the selected screen.



G: See and change the stream type.



H: Choose a preset (applicable to PTZ cameras configured with presets).



I: Search and play recordings (see normal recording playback for details).



J: Hide the toolbar area.



K: Right-click and preview live video from the binding camera.

Play Video of Multiple Cameras on Video Wall
By Play on Screen and Play on Wall, you can play video from selected cameras on a specified screen
or multiple screens of a video wall. Before you start, you need to complete the configuration of a
video wall.
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Play on Screen
Play video of multiple cameras on a screen. In this example, we split a screen (e.g., screen 1) into 4
(window 1, 2, 3, 4) to play video of four cameras.

1.

Click to select window 1 on screen 1.

2.

Select cameras on the left.

3.

Click

4.

Select a stream type.

5.

Click OK. Video from the four cameras are playing in window 1, 2, 3 and 4 on screen 1
respectively.

.

Play on Wall
Play video of multiple cameras on multiple screens on a video wall.
Play video of 7 cameras on a video wall with 4 screens, among which, screen 1 is split into 4 windows.

1.

Click to select window 1 on screen 1.

2.

Select cameras on the left.

3.

Click

.
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4.

Select the stream type.

5.

Click OK. Video from the first 4 cameras are playing on screen 1, and video from the other 3
cameras are playing on screen 2, 3 and 4 respectively.

Play Sequence Resource
Sequence resource consists of several cameras that are arranged in a certain order as a group to play
video on video wall screen(s) in sequence at the set time interval. You need to configure sequence
resource first (see Sequence Resource).
Steps
1.

Click the Sequence Resource tab (

).

2.

Select the sequence resource to play.

3.

Click to select a window or a screen. Video will start from the selected window or screen.

4.

Click

5.

Or click

to start sequence on the selected screen.
to start sequence on all the screens that are bound to decoding channels. After

sequence starts, click

/

to pause/resume, or click

to stop.

Examples
The following examples show how to play sequence resources on a video wall. Assume the time
interval is set to 20 seconds for all the sequence resources.
Example 1: Sequence 2 cameras (Cam 1 and Cam 2) on one screen
1 Start
Cam 1

2 20s
Cam 2

3 20s
Cam 1

1.

Sequence starts: play the 1st camera (Cam 1).

2.

Switch in 20 seconds: play the 2nd camera (Cam 2).

3.

Complete a round and start again: play the 1st camera (Cam 1).

4.

Repeat the above process.
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Example 2: Sequence 5 cameras (Cam 1, 2 … 5) on a 4-window screen
1 Start
Cam 1

Cam 2

Cam 3

Cam 4

2 20s
Cam 5

Cam 2

Cam 3

Cam 4

3 20s
Cam 1

Cam 2

Cam 3

Cam 4

1.

Sequence starts: play the first 4 cameras (Cam 1, 2, 3, 4).

2.

Switch in 20 seconds to play the last camera: play Cam 5 on Win 1; other windows do not
switch.

3.

Complete a round and start again: play the first 4 cameras (Cam 1, 2, 3, 4).

4.

Repeat the above process.

Example 3: Sequence 11 cameras (Cam 1, 2, 3 … 11) on a video wall (screen layout as follows)
1 Start
Cam 1

Cam 2

Cam 3

Cam 4

Cam 5

Cam 6

Cam 7

2 20s
Cam 8

Cam 9

Cam 10

Cam 11

Cam 5

Cam 6

Cam 7

3

20s

Cam 1

Cam 2

Cam 3

Cam 4

Cam 5

Cam 6

Cam 7

1.

Sequence starts: play the first 7 cameras (Cam 1, 2, 3, … 7).

2.

Switch in 20 seconds to play the next 4 cameras (Cam 8, 9, 10, 11).

3.

Complete a round in 20 seconds and start again: play the first 7 cameras (Cam 1, 2, 3, … 7).

4.

Repeat the above process.
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View Configuration
Click the View icon on Control Panel. The View page is displayed. Manage views, including the
screen layout (how many windows and how they display) and binding cameras or sequence
resources. The created view appears on the View list on the Live View page. You can start live view
and sequence by one click of the Play button.

NOTE!
Please configure the sequence resource first (see Sequence Resource) before creating a view that
involves a sequence resource.
Click Add to create a view.
1

3

6

2

5

4

7

8

1.

Enter the view name.

2.

Set screen layout (for example, 4-window display).

3.

Drag cameras to intended windows one by one to complete binding; Or click to specify a
window, select the cameras, and then click

. If binding is successful, the service name (e.g.,

Live) and camera name appears at the window center, and a link flag appears on the camera
name on the left.
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4.

Select a stream type. Select a preset (only application to PTZ cameras with configured presets).

5.

Drag sequence resources to intended windows to complete binding. If binding is successful, the
service name (Sequence) and sequence resource name appears at the window center, and a link
flag appears on the sequence resource name on the left.

6.

(Optional) Enter a brief introduction about the view.

7.

Click OK.

The name of the created view appears at the View tab on the Live View page. Start the configured
live view or sequence by just one click of the Play button (

10

).

Alarm Configuration

Click the Alarm Configuration icon on Control Panel. The Alarm Configuration page is displayed.
Create alarm plans so that the linked object(s) perform triggered action(s) when alarms occur during
a certain period. A plan mainly specifies the time template, alarm source(s), alarm type(s), linked
object(s), and action(s) to trigger.
Triggered actions include:


Live view: Display live video from the linked camera(s) in a pop-up window.



Goto preset: The linked PTZ camera rotates to a preset position (preset for short).



Alarm output: Output an alarm to external device.



Alarm to video wall: Play video from the linked camera on the video wall.

NOTE!








The time template used in an alarm plan needs to be configured beforehand under Service > Alarm
Configuration > Time Template on the Web Manager.
Only alarms that occur within the time period(s) specified in the configured time template will
trigger actions.
You may configure multiple alarm sources in an alarm plan, and specify multiple actions to trigger
for an alarm source.
New alarm plans are enabled by default and can be deleted or disabled as needed.
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Create an Alarm Plan to Trigger Live Video
Create an alarm plan so that a window pops up playing live video from linked camera(s) when an
alarm occurs.
First enable the alarm-triggered live video function: Click

in the lower left corner and select

Display Link Video.

Click Alarm Configuration > Alarm Plan > Add and then follow these steps:
1.

Complete the basic information. The time template is configured on the Web manager. New
alarm plans are enabled by default. Enable alarm sound as needed.

2.

Follow the steps to set alarm type(s) and alarm source(s). Use keywords to filter. Click
delete unneeded alarm sources.

1

2
3

4
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to

3.

Follow the steps to set linked camera(s) and action(s) to trigger (live video). Play Time means
the duration of live video to play. Click

to delete unneeded actions.

2
1

3
4

5

4.

When live video is triggered by an alarm, the window pops up displaying live video and related
alarm and camera information.
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Click

to set the screen layout (e.g., 1 window).



Lock layout: By default the check box is not selected, and the layout adapts to the number of
cameras automatically. Select the check box as needed so the layout does not change when
new alarms occur.



Lock Current Live View: By default the check box is not selected, and the current live video will
be replaced by new alarm-triggered live video. Select the check box as needed so the current
live video will not replaced, and it will not stop automatically when the set play time is over.



If the alarm source is a camera for which a hot spot has been created on the map, you may click
to open the map and locate the alarm source on the map (see E-map).



Click

in the lower left corner (see GUI Introduction) to open the Alarm Records page and

view alarm records.


Other live view operations (see Window Toolbar).

Create an Alarm Plan to Trigger Preset
Create an alarm plan so that the linked PTZ camera goes to a preset position(preset for short) when
an alarm occurs. The preset should be configured beforehand.
1.

Complete the basic information. Set alarm type(s) and source(s). See Step 1 and 2 in Create an
Alarm Plan to Trigger Live Video for details.

2.

Follow the steps to set the linked PTZ camera(s) and action to trigger (goto preset). Click
delete unneeded actions.

48

to

2
1
3

5

4

6

Create an Alarm Plan to Trigger Alarm Output
Create an alarm plan so that the linked object outputs an alarm when an alarm occurs.
1.

Complete the basic information. Set alarm type(s) and source(s). See Step 1 and 2 in Create an
Alarm Plan to Trigger Live Video for details.

2.

Follow the steps to set the linked channel(s) and action to trigger (alarm output). Click
delete unneeded actions.
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Create an Alarm Plan to Trigger Alarm on Video Wall
Create an alarm plan so that a video wall starts playing live video from the linked camera when an
alarm occurs.

Create an alarm to video wall task
NOTE!
Configure video wall first (see Video Wall).
Click Alarm Configuration > Alarm to Video Wall Task > Add and then follow the steps.
1.

Enter the task name (e.g., Task 1).

2.

Select a video wall (e.g., Video Wall 1).

3.

(Optional) Split the screen, e.g., to 4.
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4.

Drag the camera to the screen to complete binding; or select multiple cameras and then click
(see Play on Screen) or
the screen color changes,

(see Play on Wall) to bind in batches. If binding is successful,
appears in the top right corner of the screen, and the name of

the camera appears at the screen center. Select the stream type. For a PTZ camera configured
with presets, you may also select a preset.

5.

Click OK. The task appears in the Alarm to Video Wall Task list (see the figure below).

Configure alarm to video wall
1.

Complete the basic information. Set alarm type(s) and source(s). See Step 1 and 2 in Create an
Alarm Plan to Trigger Live Video for details.

2.

Follow the steps to complete alarm to video wall configuration.
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NOTE!









Click
to edit a task (button appears when the pointer hovers over the task name), or click
to add one.
If an alarm occurs when video is playing on a video wall, the video will be replaced by the alarm
video. When the set play time is over, the previous video continues.
If a video wall is used by several alarm to video wall tasks, the succeeding alarm video replaces the
preceding, and the play time resumes from 0 when the succeeding video starts on the video wall.
Closing the client software does not affect alarm video playing on the video wall.
Alarm video playing on the video wall can be replaced by live or recorded video played manually.

Alarm Sound
Set alarm sound, so the client plays an audio file or uses TTS to make sound alerts in the set format
when an alarm occurs on a specified device.

Use TTS
To play alarm sound using the Text-To-Speech (TTS) engine:
1.

Click Client Configuration on Control Panel.

2.

Enable alarm sound and then select TTS. Set repeat times as needed.
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3.

Enable alarm sound and set alarm content for the corresponding alarm plan in alarm
configuration. You may enter text in the field, or click the Expression button and choose options
in certain order. The expression includes organization, device, alarm source, alarm time and
alarm type. Each option can be chosen once only.

TIP!
You may edit TTS settings in the control panel of the Windows operating system of your client
computer, including language and voice speed. Normally there is no need to change the default
settings.

Use a Local Audio File
To play alarm sound using an audio file saved on your client computer:
1.

Click Client Configuration on Control Panel.

2.

Enable alarm sound, select Local Sound, and select an audio file (.WAV) from your client
computer. Set repeat times as needed.
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TIP!
You may also click
in the lower left corner (see GUI Introduction) and then click
on or off alarm sound on the client.
3.

11

to turn

Enable alarm sound for the corresponding alarm plan in alarm configuration.

Alarm Records

Click the Alarm Records icon on Control Panel. The Alarm Records page is displayed. View and
acknowledge alarms or query alarm records. You may click the preview button to view alarm
triggered snapshots if there are any.
Alarm levels are configured on the Web Manager (Service > Alarm Configuration > Custom Alarm
Level).
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Latest Alarms
Click the Latest Alarm tab. Latest alarms are displayed and refreshed automatically. Select records
(or click

to select all) and then click Acknowledge to acknowledge. Acknowledged alarms

disappear from the list and can be retrieved on the History tab.
Select alarm level(s) to display alarms of certain levels only. Turn on/off alarm sound as needed.

You may also click

(Latest Alarm button) in the lower left corner to view latest alarms.

History Alarms
Click the History tab. Set search conditions. View alarm details, acknowledge alarms, and export
alarm records.
All alarms can be retrieved on the History tab but not necessarily in real time.
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Sequence Resource

Select and arrange cameras in certain order as a group for use in live view and video wall. Video from
the selected cameras will be displayed in sequence at the set interval.
Click the Sequence Resource icon on Control Panel. The Sequence Resource page is displayed.
Click Add and then follow the steps to set sequence resource.
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1.

Enter the resource name.

2.

Set the time interval at which a cameras switches to the next.

3.

(Optional) Enter keywords to filter cameras.

4.

Select cameras.

5.

Click

. The selected cameras are added to the list. Click Top, Up, Down or Bottom

buttons to adjust the order.
6.

Select stream types as needed.

7.

Select presets (only applicable to PTZ cameras with configured presets).

8.

(Optional) Enter a description of the sequence resource.

9.

Click OK.

NOTE!



New sequence resources are enabled by default and display in View and Video Wall modules.
For more information about how to use sequence resource, see View Configuration and Video
Wall.
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Audio

Click the Audio icon on Control Panel. The Audio page is displayed with two tabs: Two-way Audio
and Broadcast.


Two-way audio: Bidirectional audio communication with a camera or an NVR.



Broadcast: Audio broadcast to cameras or NVRs. The camera or NVR side can only hear sound
from the client.

Two-way Audio
Click the Two-way Audio tab. You can:


Have two-way audio communication with a camera and meanwhile view live video from it.



Have two-way audio communication with an NVR.

NOTE!
Two-way audio requires a speaker and a microphone be plugged in to your client computer.
The client software can establish two-way audio with one camera or one NVR at a time.




Two-way Audio with an NVR
Double-click an NVR audio channel or drag it to the window on the right. When two-way audio is
started, the audio channel symbol changes (1), the two-way audio symbol appears at the window
center (2), and a hint appears (3) indicating two-way audio is in use.
During two-way audio, you can adjust the output sound volume at the client computer side (4) and
the input sound volume (5), or stop two-way audio (6).

1

2

3
4

5
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Two-way Audio with a Camera
Double-click the camera or drag it to the window on the right. When two-way audio is started, the
audio channel symbol changes (1), the two-way audio symbol flashes in the window's upper right
corner (2), and a hint appears indicating two-way audio is in use (3).
During two-way audio, you can adjust the output sound volume at the client computer side (4) and
the input sound volume (5), or stop two-way audio (6).
2
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NOTE!
You may also start two-way audio with a camera (camera only) by clicking
window (see Window Toolbar in Live View).

in a live view

Broadcast
Broadcast is one way, from the VMS to other devices.
Click the Broadcast tab. Select audio channels in the list on the left. You can:


Select audio channels one by one.



Select an NVR or an organization to select all audio channels under it.



Enter keywords to filter.

The selected audio channels are automatically added to the broadcast list on the right. After all the
channels are added, click

to start broadcast.
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When broadcast is started,

changes to

, and status is displayed for the audio channels.

6
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During broadcast, you can:


Add more audio channels by selecting from the list on the left. Broadcast starts automatically
for these channels.



Adjust microphone sound volume (1), or click
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to turn off microphone.



Adjust speaker sound volume (2) or turn off speaker: this operation can be performed when
audio is turned on for only one camera audio channel (3); otherwise, the button is grayed out.
Audio cannot be turned on for an NVR audio channel.



Delete audio channels from the broadcast list: click
check box (5) and then click

(4) to delete one by one; or select the

to delete in batch. Clicking

will select all channels in

the broadcast list.


End broadcast: click

or close the Audio page.

NOTE!
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Devices that support broadcast include cameras and NVRs connected via ONVIF and cameras and
NVRs added to cloud.
Broadcast and two-way audio cannot be used simultaneously.
Broadcast supports a maximum of 128 audio channels.

Client Configuration

Set parameters for the client computer where the client software is running.
Click Client Configuration on Control Panel. The Client Configuration dialog box appears. Some
parameters are described in the table below.
Parameter
Processing
Mode
Display
Mode

Description
Short Delay or Ultra-low Delay is recommended when
network connectivity is in good performance.
Fluent is recommended if there is an obvious time lag.
Choose an optimal display mode in accordance with your
client computer's performance.
Transmission protocol used to carry video streams from
front end devices to your client computer.

Audio &
Video

Video

Stream
Transmission
Protocol

Note:
 TCP is recommended in poor network conditions. After
switching from UDP to TCP, you need to restart live view
to apply the changed setting.
 Make sure the software is not blocked by firewall if you
choose UDP.


Stream
Transmission
Policy



Forwarding First: The devices send media streams to
the client software via the VMS.
Direct Connection First: The devices first try sending
media streams to the client directly; if it failed, the
devices send media streams via the VMS.
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Parameter

Description


Snapshot

Auto: Save snapshot(s) in specified format to the
specified path.
Manual: In this mode, user can select the snapshot(s) to
save, set the path and format, and enter remarks (for
JPEG only).

Snapshot
Mode



Continuous
Snapshot
Interval

Time interval between two snapshots.

Continuous
Snapshots

Number of snapshots to take every time.
Choose the format of snapshots taken to be saved on your
client computer:

Snapshot



Format


Enable Auto
Login to
EZVMS
System

Startup
Enable Auto
Login to
Windows

Operation

Alarm

Enable Alarm
Sound

BMP: Save snapshots without compression. It takes
more space than JPEG.
JPEG: Snapshots are compressed to save space at the
expense of reduced image quality.

If enabled, you will automatically log in to the most
recently accessed server address after you start the client
software.
If Enable Auto Login to Windows is enabled, the client
software will start automatically after the computer
accesses the Windows operating system.
If enabled, you will automatically log into Windows after
your client computer starts up. You need to enter the
username and password for your Windows system in the
boxes below.
Set whether to enable sound alert when an alarm occurs.
You may choose to use TTS or a local audio file to play
alarm sound (see Alarm Sound).
After completing the configuration here, you also need to
complete settings in Alarm Configuration.
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